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DCP FIRMWARE UPLOAD PROCEDURE

INTRODUCTION

This document covers the installation of the DCP Setup Software and the

procedure for upgrading the processor board and firmware in an operational DCP
unit.

N

This upgrade procedure is intended for existing DCP units in the field which are
running firmware version 1237 and using processor board A-8080-844-A. The
DCP Setup Software is used to upload and download critical firmware files
residing in the DCP unit.

This document only covers the field upgrade of existing DCP processors. For
details on the use of the DCP processor and setup software, please consult the
DCP Operations and Maintenance Manual.

FIELD UPGRADE OVERVIEW

The purpose of the DCP field upgrade is to replace the existing CPU card and
upgrade the firmware to version 2.11 without destroying the existing tuning and
calibration settings residing in the DCP unit. The DCP field upgrade consists of
the following steps.

1. Installation of the DCP Setup Software on a laptop or desktop PC running
Windows 3.1, Windows 3.11 or Windows 95.

2. Uploading the new DCP firmware version 2.11 into the existing DCP CPU
card.

3. Downloading of the SETUP.DAT file from the DCP processor. SETUP.DAT
contains the current tuning and calibration settings in the DCP processor.

4. Replace the CPU card. Upload new DCP firmware version 2.11 into the new
DCP CPU if not already installed.

5. Upload the SETUP.DAT file (created in step 3) from the PC to the new DCP
CPU card.
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SETUP SOFTWARE INSTALLATION
PC INSTALLATION

To ensure proper operation of the DCP Setup Software, install the software using
the following procedure.

1. Turn the PC on and allow Windows to start. If Windows doesn't automatically
start when the PC is powered on, enter WIN at the MS-DOS prompt to start
Windows. For additional details on starting Windows, see your Windows
documentation.

2. Insert the 3.5" DCP Setup Software installation disk into drive A or B.

3. If installing the software on a PC running Windows 3.1 or Windows 3.11,
choose the Run command from the File pull-down menu in the Windows
Program Manager. In the Command Line box, type a:install if you inserted
the installation disk in drive A or b:install if you inserted the installation disk in
drive B. If installing the software on a PC running Windows 95, choose the
Run command from the Start pop-up menu. The Start button is located in
the lower left-hand corner of the main Windows 95 display. See the Windows
documentation for additional information regarding the Run command.

4. If a previous version of the DCP Setup Software is already installed, the
installation software will display the following list of options.

De-install - removes the currently installed version of the DCP Setup
Software from the system. The DCP file directory and existing project
files (if any) are not removed.

Upgrade - only replaces the DCP program files that have changed since
that last installation of the software. The existing DCP.INI file and project
files are not overwritten or removed.

Full - A full installation is performed. (see step 5). Any project files found
in the current DCP installation directory will be copied to the new file
directory.

Choose the appropriate option. If de-install or upgrade is chosen, the specified
action is performed and the installation software will terminate. A new DCP
program group will be installed in the Windows Program Manager (if the upgrade
option is chosen).

5. If this is the first time the DCP Setup Software is being installed on the system

or if the Full option is chosen in step 4, the following installation display is
presented.
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Welcome to the DCP Setup
Software Installation Procedure
Yersion 1.734

™ Installation Setup ‘
Enter name of diwectory

where software is to be Ic;\dcp
installed:

Source Drnive:

Installation Status

File being processed: NVA

Percent installation completed: 0 %

“installation dicry, drive and clic histlli button

Enter the path name where the software should be installed (default is c:\dcp).
If the source drive is incorrect, enter the disk drive designation where the
installation disk resides (default is A:) If using the keyboard, TAB to the
respective fields and enter the data. To start the software installation, click the
Install Software Now button (or if using the keyboard, TAB to the button and
then press the ENTER key). The installation software will then copy the DCP
program files from the installation disk to the specified directory. The installation
procedure should take about 2 minutes. The DCP Setup Software requires
about 1.5 Mbytes of hard disk space. Once the installation is complete, a DCP
program group will be active in the Windows Program Manager.

DE-INSTALLATION
Use the following procedure to remove the DCP Setup Software from the PC.
1. In the DCP program group, double click the mouse on the DCP Install icon.
2. The installation software will display the following list of options.

De-install - removes the currently installed version of the DCP Setup
Software from the system. The DCP file directory and existing project
files (if any) are not removed.
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Upgrade - only replaces the DCP program files that have changed since
that last installation of the software. The existing DCP.INI file and project
files are not overwritten or removed.

Full - a full installation is performed. (see step 5 above under
Installation). Any project files found in the current DCP installation
directory will be copied to the new file directory.

Choose the de-install option. The DCP program files will be removed. In
addition, the DCP program group icon in the Windows Program Manager will also
be removed. The installation software will then terminate.

NEW FIRMWARE UPLOAD PROCEDURE

New firmware is uploaded to the DCP unit via the high speed serial port located
on the rear panel of the DCP processor. The DCP Setup Software has a built-in
Xmodem transfer protocol that ensures accurate transmission of firmware files
from the PC to the DCP hardware. The use of the DCP Setup Software
eliminates the need for using a third-party communications application to upload
new firmware.

The following describes the steps required to upload new firmware to the DCP
processor.

1. Insert the DCP firmware version 2.11 disk into drive A. If a number of field
upgrades will be performed, create a directory on the hard drive in the PC and
copy the contents from the supplied firmware disk to the directory. For details
on creating directories and copying files, consult the Window's
documentation.

2. Start the DCP Setup Software. The following display will be presented.
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3. Connect a RS-232c NULL Modem cable between the COM1 serial port on the
PC and the high speed serial port located on the rear panel of the DCP unit.
The high speed serial port is labeled “SETUP PORT”. Note: the DCP Setup
Software requires that the COM1 serial port be used for high speed data

transmissions.

4,
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In the Tools pull-down menu, select Upload New Program Code.
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A file or group of files to be uploaded can be selected via the Select Files list
box. File selection is accomplished by first scrolling the list box to view the
available files. When the desired file is visible, use the mouse to position the
cursor over the file and then press the left mouse button. Additional files can
be selected by scrolling the desired file(s) into view, placing the cursor over
the file(s) and then simultaneously pressing the Crtl key and the left mouse
button. As files are selected, the number of blocks to be transferred to the
DCP will be updated in the upper right-hand corner of the display. Each block
represents 128 bytes of file data.

Up to 30 files can be selected and uploaded to the DCP unit at one time. If
additional files are to be uploaded, split the files up into groups of 30 files (or
less) and upload each group separately. Note: Version 2.11 of the DCP
firmware consists of six files. It is important that all files shipped with
the upgrade disk be uploaded to the DCP. This includes LOADER.EXE
which has been modified since the last DCP firmware release.

4. The Select Directory button is used to launch a directory browser that can be
used to select the file directory and/or device (such as the A or B drive)
containing the firmware file(s) to upload. When launching the directory
browser the following display is presented. The files to be transfered to the
DCP-1000 include DCP.EXE & PLAYER.BIN ONLY !! DO NOT TRANSFER
ANY OTHER FILES.

DCP System Setup - Project Title: New Project ' v \
4 File Config Tools Master Test Help

Channel Mute Status

DCP Firmware Upload

" DCP Program Files [ File Transfer Status

Current Directory:

Blocks Translerred: N/A  of approx. 2288

Seleci Files: {Highlight filenames)
T Blocks Re-transmitted: 0 b |

CHECKSUM.TXT
DCP.EXE
DCP211.EXE
INDEX.BMP
INSTR.TXT
LOADER._EXE

Peircent of Fite Transferred:

0z

Est. Time to completion. 229 minutes
File: Mone

PLAYER.BIN
File Type:

All Files {*.*
Executables [~.exe)
Binaries {*.bin 4

[ Select files to upload... Eb
OFF I I OFF

[Not Connected to the DCP fooo.0 db {DREPEIUEMELR Test OFF
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A directory search is accomplished by positioning the cursor over the desired
directory and double-clicking the left mouse button. Directory and sub-
directories can be search until the desired directory is located. When a
directory is selected, the available files in the selected directory are displayed
in the list box on the left of the dialog box. Once the desired directory is
selected, use the OK button to make the selection.

5. After selecting the desired files, start the uploading procedure by selecting the
Start button. After starting the firmware upload, the Start button will be re-
labeled Stop. To abort the upload procedure, use the Stop button.

During the file upload, the status of the upload will be displayed in the File
Transfer Status block. Blocks re-transmitted indicate a possible
communications problem between the PC and the DCP unit. If re-
transmissions exceed 10 blocks, the software will automatically abort the
uploading process. If this should occur, reboot the DCP processor (i.e.,
power the unit off and then back on) and try the uploading process again.

After uploading the selected firmware files, exit the dialog box using the Done
button. When finished, power the DCP off and then back on to start the
new firmware.

6. If the DCP firmware is shipped as a compressed (packed) file that contains
many files, memory overload problems may occur when the compressed file
is unpacked after being uploaded to the DCP hardware. To avoid this
problem, the DCP Setup Software verifies that DCP.EXE (the main firmware
file) is not in packed format (i.e., the file is smaller than 150K bytes). Ifa
packed file is detected, the software will notify you that the file should first be
unpacked (i.e., expanded) on the PC hard drive and each of the individual
files should be uploaded. Note: as shipped from the Sony Cinema
Products Corporation, firmware version 2.11 is delivered in unpacked
format.

7. A complete DCP firmware upload should take approximately 3 minutes.
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RETRIEVING SETUP.DAT FROM THE DCP HARDWARE

NOTE: This procedure is ONLY required if the room “B-
Chain” alignment has already been performed with this unit. If
the unit being upgraded has not yet been aligned, this procedure

can be omitted.

SETUP.DAT contains the tuning and calibration settings currently residing on the
DCP CPU card. When the CPU card is replaced, the current settings are lost

unless the original SETUP.DAT file is re-loaded into the new CPU card.

Use the following steps to retrieve the SETUP.DAT file.

1. Start the DCP Setup Software on the PC and power-up the DCP hardware.
Verify that the DCP firmware is version 1.40 or higher. The firmware just
loaded in the previous section is version 2.11. Firmware versions can be
verified via the front panel controls of the DCP processor. For additional
details, consult the DCP Operations and Maintenance Manual. Note: most
DCPs in the field have firmware version 1.37. Make sure version 2.11 is

uploaded prior to continuing.

2. Connect a RS-232c NULL Modem cable between a serial port on the PC and
the low speed serial port located on the back panel of the DCP unit. The low

speed serial port is labeled “SDDS LINK”.

3. Connect to the DCP unit using the Connect to DCP menu option located in

the Config pull-down menu in the DCP Setup Software.

DCP System Setup - Project Title: New
| Config

When selecting Connect to DCP, the following dialog box will be displayed.
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| Connect t

~ Port
COM1 {*' COM1
{ COM2
 COM3
C COM4

DCP Serial Number: (00000

Select the serial port (i.e., COM1, COM2, etc.) where the RS-232¢ NULL
Modem cable is attached. Currently, the DCP Serial Number field can be
ignored (a future enhancement). Prior to connecting to the DCP, place the
DCP hardware into “Laptop” mode. Use the front panel cursor keys to
position the highlight bar over the Config menu option and then press the
Select key. After pressing the Select key, a DCP password display will be
presented. Using the left-right cursor keys, position the highlight bar over the
desired digit and enter the appropriate number using the up-down cursor
keys. After entering the DCP serial number, a configuration menu will be
displayed. Use the left-right cursor keys to position the highlight bar over the
Laptop menu option and then press the Select key. The DCP is now ready
for communications with the DCP Setup Software. To complete the
connection, select the Connect button in the Connect to DCP dialog box.

4. After connecting to the DCP unit, select Retrieve Code from DCP from the
Tools pull-down menu in the DCP Setup Software.
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+ DCP System Setup - Project Title: New Project

el Mute Status

The following display will be presented.

etrieve File ﬁom DC

Name of file in the DCP to retrieve: |m

File Saved As: C:ADCP\setup.dat

Enter name of file to retrieve from the DCP |

By default, SETUP.DAT is the file retrieved from the DCP unit and placed in
the current directory where the DCP Setup Software is installed.
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5. The Select/Create File button is used to launch a “Save DCP File As”
function that is used to select an alternative location and file name where the
file from the DCP should be stored. When launching the function the
following display is presented.

Save DCP File As

autoansi.exe
bc40rtldll
dcp.hlp
dcp.ini
dcpwin.exe
install.exe
readme.txt

Directory selection is accomplished by positioning the cursor over the desired
directory and double-clicking the left mouse button. Directory and sub-
directories can be search until the desired directory is located. When a
directory is selected, the available files in the selected directory are displayed
in the list box on the left side of the dialog box. Either select an existing file
(i.e., position the cursor over the file name and double clicking the left mouse
button) or enter a new file name in the “File name” edit field. Once the

desired directory and file name is selected, use the OK button to make the
selection.

6. Start the retrieval procedure by selecting the Start Transfer button. After
starting the file download process, the Start Transfer button will be re-labeled
Stop Transfer. To abort the upload procedure, use the Stop Transfer
button. During file retrieval, the status of the download will be displayed inthe
status window at the bottom of the display. Blocks re-transmitted indicate a
possible communications problem between the PC and the DCP unit. If re-
transmission tries exceed 10 blocks, the software will abort the retrieval
process. Each block represents 128 bytes of file data.

CPU CARD REPLACEMENT
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Once the SETUP.DAT file has been retrieved from the existing DCP CPU card,

the new CPU card can be installed. Use the following steps to replace the CPU
card.

1. Power the DCP unit off and disconnect the power cord.

2. The CPU card is removed from the DCP unit via the rear panel. Using a #2

Phillips screwdriver, remove the two retaining screws holding the CPU card in
the DCP card frame.

3. Carefully slide the CPU card out of the card frame. A ribbon cable attached

to the CPU card must be disconnected prior to complete removal of the
CPU card.

4. Unwrap the new CPU card (part number A-8080-844-B) and carefully slide
the CPU card into the vacated slot. Prior to sliding the CPU card all the way
into the slot, re-attach the ribbon cable to the connector on the CPU card.
Once the ribbon cable is re-attached, slide the card all the way into the slot
until seated.

5. Re-attach the retaining screws, connect the power cord and power the DCP
unit on.

6. Verify that firmware version 2.11 is installed on the new CPU card. The
firmware version can be determined using the front panel controls of the DCP
unit. For additional details on using the DCP front panel, please consulit the
DCP Operations & Maintenance Manual.

UPLOADING SETUP.DAT TO THE NEW DCP CPU CARD

SETUP.DAT is uploaded to the DCP unit via the high speed serial port located
on the rear panel of the DCP processor. The DCP Setup Software has a built-in
Xmodem transfer protocol that ensures accurate transmission of firmware files
from the PC to the DCP hardware. The use of the DCP Setup Software
eliminates the need for using a third-party communications application to upload
new firmware.

The following describes the steps required to upload SETUP.DAT to the DCP
processor. Note: DCP firmware version 2.11 must be loaded in the DCP unit
prior to uploading the SETUP.DAT file. See the previous section for details.

1. Start the DCP Setup Software on the PC. The following display will be
presented.

page 15 5/6/97



DCP FIRMWARE UPLOAD PROCEDURE

2.

3.
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Connect a RS-232¢c NULL Modem cable between the COM1 serial port on the
PC and the high speed serial port located on the rear panel of the DCP unit.
The high speed serial port is labeled “SETUP PORT". Note: the DCP Setup
Software requires that the COM1 serial port be used for high speed data

transmissions.

In the Tools pull-down menu, select Upload New Program Code.
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+ DCP System Setup - Project

The following display will be presented.

I DCP Firmware Upload

—DCP Program Files —File Transfer Status
Current Duectory:
A\
Select Files: (Highlight filenames) Blocks Transferred: N/A  of approx. 1
DCP20.EXE P Blocks Re-trangmitted: 0
P20.71
PNCDEX%HPP Percent of File Transferred:
INSTR.TXT 0%
LOADER.EXE
ga\[))iREBT'QT Est. Time to completion: (.00 minutes

File: Mone

File Type: XTI Y @
Executables [*.exe)
Binanes [*.bin)

BSelect files to upload... E

A file or group of files to be uploaded can be selected via the Select Files list
box. File selection is accomplished by first scrolling the list box to view the
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available files. When the desired file is visible, use the mouse to position the
cursor over the file and then press the left mouse button. Additional files can
be selected by scrolling the desired file(s) into view, placing the cursor over
the file(s) and then simultaneously pressing the Crtl key and the left mouse
button. As files are selected, the number of blocks to be transferred to the

DCP will be updated in the upper right-hand corner of the display. Each block
represents 128 bytes of file data.

Up to 30 files can be selected and uploaded to the DCP unit at one time. If
additional files are to be uploaded, split the files up into groups of 30 files (or
less) and upload each group separately.

4. The Select Directory button is used to launch a directory browser that can be
used to select the file directory and/or device (such as the A or B drive)
containing SETUP.DAT to upload. When launching the directory browser the
following display is presented.

A directory search is accomplished by positioning the cursor over the desired
directory and double-clicking the left mouse button. Directory and sub-
directories can be search until the desired directory is located. When a
directory is selected, the available files in the selected directory are displayed
in the list box on the left of the dialog box. Once the desired directory is
selected, use the OK button to make the selection.

5. After selecting SETUP.DAT, start the uploading procedure by selecting the
Start button. After starting the upload, the Start button will be re-labeled
Stop. To abort the upload procedure, use the Stop button.

After starting the uploading procedure, reboot the DCP by powering the unit
off and then back on. Once rebooted, the setup software will establish
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communications with the DCP unit and start the file transfer process. During
the file upload, the status of the upload will be displayed in the File Transfer
Status block. Blocks re-transmitted indicate a possible communications
problem between the PC and the DCP unit. If re-transmissions exceed 10
blocks, the software will automatically abort the uploading process. If this
should occur, reboot the DCP processor (i.e., power the unit off and then
back on) and try the uploading process again.

After uploading SETUP.DAT, exit the dialog box using the Done button.
When finished, power the DCP off and then back on to start the firmware
using the parameters in SETUP.DAT.
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FURTHER INFORMATION

If you have any questions regarding the DCP Setup Software please contact.

Sony Cinema Products Corporation Engineering
3830 Clarington Ave.

Los Angeles, CA 90232

(310) 559-4811 Phone

(310) 559-4097 FAX
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